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1. Введение 

В последние десятилетия происходит стремительное развитие 

светодиодной техники: от маломощных индикаторных светодиодов до 

современных сверхъярких осветительных светодиодов и светильников. 

Ввиду высокой конкуренции в данной отрасли промышленности, 

оптимизация параметров самих светодиодов, а также осветительных 

приборов на их основе, является ключевой задачей для получения 

качественных и успешных коммерческих продуктов. Производство 

светодиодных осветительных приборов высокотехнологично и наукоемко, 

поэтому технологам и инженерам приходится решать сложные задачи на 

всех этапах технологического процесса, включающего например 

минимизацию механических напряжений, возникающих в 

полупроводниковой гетероструктуре, или оптимизацию теплоотвода 

радиатором конечного продукта – светодиодной лампы или светильника. 

Большую помощь в решении указанных задач оказывают современные 

вычислительные программы и комплексы компьютерного моделирования 

различных физических процессов с возможностью оптимизации 

параметров модели. 

Настоящий лабораторный практикум предназначен для 

ознакомления с возможностями программных комплексов ANSYS и 

COMSOL, позволяющих проводить широкий спектр инженерных расчетов, 

что иллюстрируется во втором разделе настоящего пособия. На примере 

учебных задач по расчету напряженно-деформированного состояния в 

тонкой пластине, ослабленной малым круглым отверстием, а также в 

полом толстостенном цилиндре под внутренним давлением (лабораторные 

работы № 1 и 2) подробно рассмотрены основные этапы численного 

решения механических задач в программном комплексе конечно-

элементного анализа ANSYS. Лабораторная работа № 3 посвящена 

численному решению задачи о нахождении остаточных термических 

напряжений в тонкой пленке нитрида галлия на подложке из сапфира. Для 

всех указанных задач приведены теоретические справки с аналитическим 

решением. Моделирование теплообмена в светодиодном модуле при 

помощи программного комплекса COMSOL описывается в лабораторной 

работе №4. Моделирование теплообмена в светодиодных модулях 

позволяет решать задачи, направленные на уменьшение температуры его 

ключевых компонентов (активная область светодиодных чипов, 

люминофоросодержащее покрытие). Лабораторная работа №5 описывает 

численное моделирование процесса теплообмена радиатора ретрофитной 

светодиодной лампы. Моделирование теплообмена радиатора включает в 

себя расчет конвекции. Лабораторная работа №6 посвящена анализу 

полученных в работах 4 и 5 результатов, углубленный анализ результатов 

необходим для составления правильных выводов о картине тепловых 
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потоков в исследуемых светодиодных устройствах и поиска путей 

улучшения теплоотвода в них. 

Представленные в пособии лабораторные работы относятся к курсу 

«Физическое материаловедение светодиодных наноматериалов», 

подготовленному на кафедре светодиодных технологий ФОИСТ НИУ 

ИТМО. 

2. Применение компьютерного моделирования в светодиодных 

технологиях 

В настоящий момент в мире происходит переход от традиционных 

систем освещения на основе ламп накаливания и газоразрядных ламп к 

твердотельным светодиодным системам освещения на основе 

полупроводниковых гетероструктур. По прогнозам 70% систем освещения 

в развитых странах к 2020 году будет использовать светодиодные 

решения. Основные преимущества осветительных устройств на основе 

светодиодов хорошо известны, — это большой срок службы, малое 

энергопотребление, широкий диапазон рабочих температур, высокий 

уровень безопасности, безынерционность, компактность и т.п. В то же 

время, светодиодные системы, являющиеся продуктом высоких, а потому 

затратных технологий, пока ещё весьма дороги в производстве и обладают 

достаточно большим сроком окупаемости. В связи с этим крайне 

актуальными являются задачи повышения их эффективности и 

надёжности, а также увеличения срока службы. Российская компания 

«Оптоган», обладающая технологиями и полным циклом производства 

светодиодов, светодиодной техники и интеллектуальных систем 

освещения, совместно с кафедрой светодиодных технологий НИУ ИТМО 

проводит научные исследования, направленные на улучшение показателей 

производимых осветительных приборов и систем. Применение 

современных программных комплексов ANSYS и COMSOL позволяет 

успешно решать следующие важные задачи: контроль механических 

напряжений в светодиодных подложках и оптимизация свободно-

конвективного теплоотвода радиатора. 

2.1. Контроль механических напряжений в светодиодных 

подложках 
В основе любого светодиода лежит полупроводниковая 

наногетероструктура, при протекании тока через которую излучается свет. 

Гетероструктура состоит из довольно толстой подложки и ряда слоев 

полупроводниковых материалов, отличающихся своим химическим 

составом, толщиной и типом проводимости. Вследствие неоднородности 

состава эти слои имеют разные механические свойства, в том числе  

коэффициенты термического расширения, что может приводить к 

неоднородной деформации при нагреве/остывании и, в конечном счете, к 
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деградации полупроводниковой структуры за счет появления трещин и 

других дефектов. Минимизация механических напряжений является 

важной задачей для получения качественных подложек и светодиодов на 

их основе. 

Одним из способов контроля уровня механических напряжений в 

подложках является формирование промежуточного слоя наноколонок или 

пор.  

Сотрудники компании «Оптоган» совместно со специалистами 

кафедры светодиодных технологий НИУ ИТМО провели ряд исследований 

влияния промежуточного слоя наноколонок на перераспределение 

остаточных термических напряжений в светодиодных подложках GaN-на-

сапфире. 

Для численного моделирования напряженно-деформированного 

состояния в подложках GaN-на-сапфире применялся программный 

комплекс ANSYS Mechanical, использующий метод конечных элементов. 

Расчеты были проведены в рамках линейно-упругой анизотропной модели 

поведения материалов с упругими модулями и коэффициентами 

термического расширения, выбранными для GaN и сапфира в соответствии 

с данными, приведенными в работах [1-3].  

Геометрия расчетной модели, учитывающей наличие специально 

сформированного промежуточного слоя, который состоит из наноколонок 

GaN, представлена на Рис. 1.  

Варьируемыми параметрами являлись относительный диаметр 

наноколонок 𝐷/𝑊 и толщина верхнего слоя GaN 𝐻3. С помощью 

встроенного языка программирования APDL были написаны макросы, 

позволяющие проводить параметрический анализ напряженно-

деформированного состояния в указанной структуре.  

В качестве граничных условий на двух смежных боковых гранях 

было задано условие симметрии, а нагрузка была задана в виде 

собственной деформации, соответствующей уменьшению температуры на 

1000 K. 

Критерием релаксации напряжений было выбрано изменение 

гидростатического давления, равного по модулю следу тензора 

напряжений: 𝑡𝑟(𝜎) = 𝜎𝑥𝑥 + 𝜎𝑦𝑦 + 𝜎𝑧𝑧), т.к. оно инвариантно относительно 

преобразований системы координат. Нормированное осредненное по 

объему гидростатическое давление: 𝑡𝑟(𝜎)/𝑡𝑟𝑝𝑜𝑟𝑒𝑙𝑒𝑠𝑠(𝜎) (где 𝑡𝑟𝑝𝑜𝑟𝑒𝑙𝑒𝑠𝑠(𝜎) – 

след тензора напряжений для структуры без промежуточного слоя 

наноколонок) характеризует степень релаксации напряжений.  

В результате анализа более 20 геометрических конфигураций, была 

выбрана оптимальная по критерию минимизации напряжений (степень 

релаксации около 15%), удовлетворяющая технологическим требованиям 

на светодиодные подложки: 𝐻3 = 0.5 мкм, 
𝐷

𝑊
= 0.7. 
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Рис. 1 Параметрическая геометрия расчетной модели подложки GaN-на-

сапфире 

На Рис. 2 а показана зависимость степени релаксации 

нормированных осредненных гидростатических напряжений для 

некоторых из рассмотренных геометрических конфигураций. На Рис.2 б 

показаны распределения нормированных гидростатических напряжений в 

осевом сечении наноколонок для следующих геометрических 

конфигураций: 𝐻3 = 0.5 мкм, 
𝐷

𝑊
= 0.3 и 0.7. Видно, что наибольшая 

релаксация напряжений наблюдается внутри наноколонок. 

 

  
а б 

Рис. 2 Результаты расчетов: а – зависимость степени релаксации 

нормированных осредненных гидростатических напряжений; б – 

распределения нормированных гидростатических напряжений в осевом 

сечении наноколонок при: 𝐻3 = 0.5 мкм, 
𝐷

𝑊
= 0.3 и 0.7 
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2.2. Улучшение свободно-конвективного теплоотвода радиатора 

 

Обеспечение теплового режима светодиодных ламп является 

ключевым элементом для повышения эффективности работы и 

долговечности светодиодных устройств. Это обусловлено тем, что 

повышение температуры активной зоны светодиода влечет за собой 

падение эффективности работы светодиода и сокращение времени его 

службы.  

Белые светодиоды, которые используются в большинстве 

светодиодных источников света, содержат крайне уязвимый для высоких 

температур элемент – люминофор (специальный состав веществ, который 

наносится на светодиод и преобразует синий свет светодиодного чипа в 

белый). 

Все люминофоры обладают эффектом термического гашения 

(эффект резкого падения эффективности светодиода), который 

наблюдается уже при 80-100°С, кроме того, при повышении температуры 

деградация люминофоров в белых светодиодах ускоряется [4, 5].  

Сотрудники кафедры светодиодных технологий проводили 

качественное и количественное исследование влияния формы радиатора на 

теплоотвод светодиодной лампы, была проведена оценка эффективности 

теплоотвода пластиковых радиаторов для светодиодных ламп «Оптоган», а 

также разработаны предложения по их оптимизации. 

Свободная конвекция является процессом, определяющим 

теплоотвод от радиаторов, поэтому ее точное моделирование важно для 

предсказания и контроля тепловых режимов светодиодных светильников. 

При моделировании теплообмена рассчитывалось течение газа в 

окрестности радиатора. Для этого была создана цилиндрическая расчетная 

область, содержащая радиатор (Рис. 3), данная область имела следующие 

примерные размеры: 7 диаметров радиатора в поперечном направлении, 20 

диаметров радиатора в продольном направлении. Огибающая радиатора 

повторяла форму стандартной 60 Вт лампы накаливания.  

Расчеты газовой фазы проводились с учетом объемных сил, 

участвующих в создании конвективных потоков. Также, был произведен 

совместный расчет теплообмена в частях лампы. 

Граничное условие на тепловой поток задавалось под светодиодным 

модулем, суммарное значение теплового потока было равно 0.9 Вт, что 

соответствует 3.6 Вт для всей лампы.  

Рассчитывалась четверть конструкции, на плоскостях симметрии 

ставилось граничное условие симметрии. На выходных границах 

ставились мягкие граничные условия для скорости газа (
𝜕𝑉

𝜕𝑛
= 0), 

граничные условия для расчета энергии задавались в виде температуры 

равной 25°С. 



9 

 

 
Рис. 3 Схема расчетной области и граничные условия 

Расчетная сетка состояла из более чем 9000000 элементов (Рис. 4). 

 

 
Рис. 4 Расчетная сетка в окрестности радиатора 

Изменение геометрической формы радиатора с целью его 

оптимизации осуществлялось за счет изменения сечения межреберного 

пространства (Рис. 3), представляющего из себя трапецию. 

В таблице 1 представлены свойства материалов радиатора, 

использованных в исследовании. 

Для оценки результатов использовалось число Нуссельта, 

характеризующее отношение интенсивности конвективного и 

диффузионного теплообмена (более подробное описание будет приведено 

в лабораторной работе №5). 
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Таблица 1 Свойства материалов теплоотводящей системы 

светодиодного светильника 

Материал Теплопроводность, Вт/м/К 

Алюминий 237 

Теплопроводящий пластик 8 

Материал светодиодного 

модуля 

0.5 

 

Максимальная разница температур в пластиковом радиаторе 

достигает 12°С, максимум расположен под алюминиевой пластиной, а 

минимум в наиболее удаленной от пластины части радиатора. При этом, 

поперечный градиент температур в ребрах оказывается значительно 

меньше продольного (Рис. 5). 

 

 

Рис. 5 Распределение температуры на поверхности лампы и в плоскостях 

симметрии в газовой фазе 

Из распределения числа Нуссельта по поверхности лампы видно, что 

наиболее интенсивный конвективный теплоотвод происходит на внешней 

части поверхности ребер радиатора (Рис. 6).  

Сравнивая распределение чисел Нуссельта для различных 

конфигураций геометрии радиатора (Рис. 7), можно прийти к выводу, что 

определяющим фактором в свободноконвективном теплоотводе является 

ширина межреберного пространства, и что наименьшей из исследованных 

толщин ребер (≈1 мм) достаточно для обеспечения необходимого 

теплообмена внутри ребер. 
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Рис. 6 Распределение числа Нуссельта по поверхности лампы 

 

Рис. 7 Распределение числа Нуссельта по поверхности ребер радиатора для 

вариантов геометрии: N = 18, 26, 24, d = 7mm, 7mm, 4mm, α = 100°, 100°, 

95° (слева направо, соответственно) 

Полученные результаты позволяют сделать следующие выводы:  

1. Ширина межреберного пространства является ключевым 

фактором свободноконвективного теплоотвода с ребер радиатора и имеет 

большее влияние на теплоотвод, чем толщина ребер; 

2. Создание тонких ребер (≈1мм) из теплопроводящего пластика не 

приводит к возникновению избыточного термического сопротивления в 

них и позволяет использовать данные пластики для производства 

эффективных радиаторов; 

3. В радиаторах на основе теплопроводящих пластиков возникает 

проблема избыточного термического сопротивления вдоль радиатора, что 

значительно ухудшает работу его частей, удаленных от источника тепла, 
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возможным решением данной проблемы может быть включение 

распределителей тепла в конструкцию радиатора. 
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3. Лабораторные работы по расчету механических  свойств 
материалов 

3.1. Введение в ANSYS. Плоские задачи теории упругости. Растяжение 

пластины с круглым отверстием в одном направлении (задача Кирша) 

[Лабораторная работа №1] 

 

Краткое описание работы 

Имеется тонкая пластина из однородного изотропного материала с 

модулем Юнга 𝐸 = 2 ∙ 105 МПа и коэффициентом Пуассона 𝜈 = 0.3 с 

круглым отверстием, малым по сравнению с размером пластины, 

нагруженная постоянным растягивающим усилием 𝑝 = 10 МПа. Размеры 

пластины 𝐿 = 1 мм, радиус отверстия 𝑅 = 0.05 мм (Рис. 8). В 

предположении о том, что реализуется плоское напряженное состояние, 

требуется с помощью программного комплекса конечно-элементного 

анализа ANSYS получить напряженно-деформированное состояние 

пластины, вычислить коэффициент интенсивности напряжений. Получить 

сеточную сходимость. Сравнить полученные результаты с аналитическим 

решением. 

 

Рис. 8 Исходные данные 

Цель работы 

Ознакомление с возможностями программного комплекса ANSYS 

при анализе напряженно-деформируемого состояния конструкций, 
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получение базовых навыков работы с комплексом: постановка задачи о 

плоском напряженном состоянии, создание сетки конечных элементов, 

приложение граничных условий и внешних нагрузок, запуск на счет и 

анализ полученных результатов. 

Общие сведения об использовании программного комплекса ANSYS 

Программный комплекс ANSYS широко применяется для 

структурного анализа (напряженно-деформированное состояние 

различных инженерных конструкций, оценка их надежности, 

долговечности и возможности оптимизации). Для этих целей используется 

программный продукт ANSYS Mechanical, основанный на методе 

конечных элементов (МКЭ).  

Любой структурный анализ включает 4 этапа: 

1. Постановка задачи 

a. Выбор типа анализа исходя из особенностей конструкции, свойств 

материала и условий нагружения 

b. Выбор оптимальной расчетной модели исходя из размерности 

задачи (2D, 3D), наличия симметрии 

c. Выбор типа элементов 

2. Подготовка расчетной модели (preprocessing) 

a. Задание свойств материала 

b. Создание или импорт геометрии 

c. Генерация КЭ сетки 

3. Расчет (solution) 

a. Приложение нагрузки и граничных условий 

b. Запуск расчета 

4. Обработка результатов (postprocessing) 

a. Просмотр результатов 

b. Проверка адекватности решения 

c. Сохранение результатов 

 

Рассмотрим этапы работы с программой [1]. 

Подготовка модели — работа в препроцессоре Main Menu > 

Preprocessor. 

При работе с программой все величины должны вводиться в 

согласованных единицах, например единицах СИ или технических. В 

явном виде единицы нигде не указываются. При вводе вещественных 

чисел используется точка, а не запятая. 

Можно начать с создания геометрического объекта. Эта часть может 

быть заменена импортом геометрии из различных программ 

автоматизированного проектирования (CAD) Main Menu > Preprocessor > 

Modelling. Самый удобный способ создания геометрии — путь от 

простого к сложному, то есть построение точек (keypoints) и далее линий 

(lines), поверхностей (areas) и объемных тел (volumes). При этом один и 

тот же результат может быть получен разными способами.  
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Любая геометрия модели состоит из объемов, поверхностей, линий, 

ключевых точек: 

 Объемы Volumes ограничены поверхностями. Они представляют 

собой твердотельные объекты. 

 Поверхности Areas ограничены линиями. Представляют грани 

твердых тел, или пластины и оболочки. 

 Линии Lines ограничены точками. Представляют ребра объектов или 

линии для линейных элементов (балок, пружин и т.д.). 

 Keypoints это точки в пространстве, являющиеся вершинами 

объектов. 

Кроме того, геометрию модели можно создавать и модифицировать с 

помощью булевых операций (Main Menu > Preprocessor > Modelling > 

Operate > Booleans): объединение, пересечение, вычитание объектов и т.д. 

После того, как создана геометрия модели, нужно выбрать, с 

помощью каких конечных элементов будет решаться задача: Main Menu > 

Preprocessor > Element Type. Для этого надо решить, какой тип расчета 

необходим (например, структурный или тепловой), какова размерность 

задачи (плоская (2D) или трехмерная (3D)),  какая точность расчета 

требуется (используются элементы первого или второго порядка).  

Также необходимо задать свойства материалов (их может быть 

несколько, у каждого свой уникальный порядковый номер), из которых 

сделана конструкция — Main Menu > Preprocessor > Material Props. 

Наконец, необходимо задать граничные условия и нагрузки в Main 

Menu > Preprocessor > Loads и Main Menu > Solution > Define Loads, 

соответственно. 

Имеется следующие основные категории нагрузок: 

 ·Степени свободы (DOF). Задание значений степеней свободы: 

перемещения, повороты и температуры. 

 Сосредоточенные, точечные нагрузки. 

 Поверхностные. Нагрузки, распределенные по поверхности, такие, 

как давление или тепловые потоки. 

 Объемные нагрузки, такие, как температура или внутренний 

источник тепла. 

 Инерционные нагрузки. Нагрузки, вызванные массой (инерцией): 

сила тяжести или угловая скорость. 

После того, как расчетная модель готова, приступаем 

непосредственно к решению задачи — заданию параметров и запуску 

расчета Main Menu > Solution. 

Здесь также можно задать граничные условия и нагрузки Main 

Menu> Solution > Define Loads, определить тип расчета Main Menu > 

Solution >Analysis Type и его настройки. 

По окончании решения задачи приступаем к просмотру результатов 

в Main Menu > General Postproc. После окончания расчета можно 
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посмотреть распределения деформаций, перемещений, напряжений, и т.д., 

построить графики и сохранить в файл численные значения для отчетов. 

 

Теоретическая справка 

Для данной задачи в полярных координатах напряжения 𝜎𝑟 
(радиальная компонента), 𝜎𝜑 (окружная компонента) и 𝜏𝑟𝜑 (касательное) 

определяются формулами [2]: 

𝜎𝑟 =
𝑝

2
[(1 −

𝑅2

𝑟2
) + (1 − 4

𝑅2

𝑟2
+ 3

𝑅4

𝑟4
) cos 2𝜑] ; 

𝜎𝜑 =
𝑝

2
[(1 +

𝑅2

𝑟2
) − (1 + 3

𝑅4

𝑟4
) cos 2𝜑] ; 

𝜏𝑟𝜑 = −
𝑝

2
[(1 + 2

𝑅2

𝑟2
− 3

𝑅4

𝑟4
) sin 2𝜑]. 

На границе отверстия (при 𝑟 = 𝑅) 𝜎𝑟 = 0, 𝜎𝜑 = 𝑝(1 − 2 cos 2𝜑). 

Получим коэффициент концентрации напряжений: 

𝐾𝜑 =
(𝜎𝜑)𝑚𝑎𝑥

𝑝
= 3, при 𝜑 = ±

𝜋

2
. 

Из формулы выше видно, что окружные напряжения на границе 

отверстия в три раза превосходят напряжения в аналогичной конструкции 

без отверстия, а при удалении от отверстия напряжения быстро спадают к 

номиналу приложенного давления.  

 

Порядок выполнения работы 

Рассматриваемая задача может быть решена в плоской (2D) 

постановке с реализацией плоского напряженного состояния. Данное 

предположение возможно вследствие того, что пластина достаточно 

тонкая и внешняя нагрузка распределена симметрично относительно 

средней плоскости пластины по толщине, что обеспечивает выполнение 

условия 𝝈̿ ∙ 𝒏̅ = 𝟎̅, где 𝝈̿ – тензор напряжений, 𝒏̅ – вектор нормали к 

плоскости пластины (плоскости ХУ). 

Кроме того, ввиду симметрии геометрии и приложенной нагрузки, в 

расчетной модели будем рассматривать четверть пластины.  

1) Создание квадрата — четверти рассматриваемой области. 

Использовать функцию построения прямоугольников на плоскости 

Main Menu > Preprocessor > Modeling > Create > Areas > Rectangle > 

By 2 Corners. 

2) Создание круга для моделирования отверстия. 

Main Menu > Preprocessor > Modeling > Create > Areas > Circle > Solid 

Circle.  

3) Создание отверстия при помощи операции вычитания объектов. 

Вырезать из квадратной поверхности новый круг: 

Main Menu > Preprocessor > Modelling > Operate > Booleans > Subtract 

> Areas.  
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В появившемся окне выбрать поверхность, из которой происходит 

вычитание, нажать OK, затем выбрать вычитаемую поверхность — малый 

круг. 

Пошаговое создание геометрии модели показано на Рис. 9. 

 

 
Рис. 9 Пошаговое создание геометрии модели в ANSYS 

4) Задание свойств материала. 

Выбрать линейно-упругий изотропный материал: 

Main Menu > Preprocessor > Material Props > Material Models. 

Для материала номер 1 (левая панель) выбрать Structural > Linear > 

Elastic > Isotropic и ввести модуль Юнга EX и коэффициент Пуассона 

PRXY. 

5) Задание элементов и их свойств. 

Перед созданием сетки необходимо выбрать тип элементов и 

добавить его из библиотеки элементов Main Menu > Preprocessor > 

Element Type > Add/Edit/Delete > Add, выбрать группу элементов 

Structural solid и в ней 4-х узловой элемент Quad 4node 182.  

В оставшемся окне для этого элемента необходимо задать 

дополнительные свойства, нажать Options. Выбрать опцию плоского 

напряженного состояния Element behavior K3 -plane stress.  

6) Создание сетки конечных элементов. 

Переходим к созданию сетки: Main Menu > Preprocessor > Meshing. 

Сетка строится в окне MeshTool: Main Menu > Preprocessor > Meshing 

> MeshTool.  

Необходимо создать адекватную задаче сетку конечных элементов: 

вблизи отверстия ожидаются значительные градиенты напряжений, 

поэтому в этой области сетка должна быть мельче, чем на периферии, где 

ожидается однородное поле напряжений. Таким образом, требуется 

переменный размер элементов. 

Это делается следующим образом: MeshTool > Size Controls > Lines 

> Set, выбрать линию. Задать NDIV No of element divisions — число 

элементов на стороне. Для прямых, прилегающих к отверстия, нужно 

дополнительно задать параметр сгущения: SPACE Spacing ratio. Для 

остальных сторон это поле следует оставить пустым (или равным 1).  
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Для прямых, прилежащих к отверстию, зададим NDIV = 20,  SPACE 

= 0.25; 

для двух оставшихся прямых зададим NDIV = 10,  SPACE = 1; 

для дуги окружности зададим NDIV = 10,  SPACE = 1. 

Создадим сетку с помощью команды: Utility Menu > Meshing > 

MeshTool. В окне Mesh выбрать Areas — разбивка поверхностей, — 

установить флажок Free, выбрать треугольный элемент Tri и нажать 

кнопку Mesh. Мышью выбрать поверхность и нажать OK. Будет создана 

сетка, показанная на Рис. 10. 

 

 
Рис. 10 Конечно-элементная сетка 

7) Задание нагрузок и граничных условий. 

К правой границе приложено растягивающее усилие, на прямых 

линиях, прилежащих к отверстию, ставятся условия симметрии: UX=0 или 

UY=0, соответственно. 

 Зафиксировать степени свободы на заданной линии можно 

следующим образом: Preprocessor > Loads > Define Loads > Apply > 

Structural > Displacement > On Lines, 

· выбрать мышью линию и нажать кнопку OK; 

· выбрать в списке DOFs to be constrained фиксируемые степени 

свободы. По умолчанию задается нулевое перемещение — Value можно не 

вводить. Включить режим отображения граничных условий и нагрузок: 

Utility Menu > PlotCtrls > Symbols, поставить флажок All BC+Reactions. 

Приложить растягивающее усилие можно следующим образом: 

Preprocessor > Loads > Define Loads > Apply > Structural > Pressure > 

On Lines. 
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Выбрать мышью нужную линию и нажать кнопку OK. В поле Load 

PRES value ввести значение давления (растяжение – знак минус). 

8) Запуск солвера (программного обеспечения, предназначенного 

для решения рассматриваемой математической задачи). 

По умолчанию в ANSYS предполагается, что в задаче 

рассматривается статическая задача с упругими свойствами материалов, 

поэтому никаких предварительных настроек решателя делать не надо. 

Запуск задачи на счет производится командой Solution > Solve > Current 

LS. Если нет сообщений об ошибках, в появляющемся диалоговом окне 

следует нажать кнопку OK. 

9) Обработка полученных результатов. 

По окончании расчета результаты анализируются в постпроцессоре 

(вкладка General Postproc). 

Адекватность результатов можно первоначально оценить по 

картине деформаций: General Postproc > Deformed Shape и выбрать 

режим отображения Def + undeformed. В случае нереалистичной картины 

следует искать ошибку в постановке задачи и в значениях заданных 

величин. 

Для получения коэффициента концентрации напряжений (𝐾𝜑)𝐴𝑁𝑆 

следует вывести на экран поле компоненты напряжений 𝜎𝑥𝑥: General 

Postproc > Contour plot > Nodal Solution > Stress > X-component of stress. 

На шкале можно увидеть максимальное значение напряжений. Более 

универсальный способ получения максимального значения указанной 

компоненты напряжений следующий: Utility Menu > List > Results > 

Nodal Solution > Stress > X-component of stress. В открывшемся файле в 

конце приведены максимальные и минимальные значения и номера 

соответствующих узлов. 

Полученное значение коэффициента концентрации напряжений 

(𝐾𝜑)𝐴𝑁𝑆 имеет значительное отличие от аналитического, следовательно, 

требуется более мелкое разбиение сетки. 

Для того, чтобы модифицировать сетку, нужно удалить 

приложенные граничные условия (поскольку они однозначно связаны с 

узлами конечных элементов, которые будут изменены): Solution > Define 

Loads > Delete > All Load Data > All Loads&Opt. Также нужно удалить 

сетку конечных элементов: Preprocessor > Meshing > MeshTool > Clear > 

Pick all.  

Далее повторить шаги 6 – 9 со следующими параметрами: 

А) Для прямых, прилежащих к отверстию NDIV = 30,  SPACE = 0.25; 

     для двух оставшихся прямых  NDIV = 15,  SPACE = 1; 

     для дуги окружности  NDIV = 15,  SPACE = 1. 

Б) Для прямых, прилежащих к отверстию NDIV = 40,  SPACE = 0.25; 

     для двух оставшихся прямых NDIV = 20,  SPACE = 1; 

     для дуги окружности NDIV = 20,  SPACE = 1. 
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10) На основе полученных результатов построить график 

зависимости  коэффициента концентрации напряжений от числа элементов 

сетки N: (𝐾𝜑)𝐴𝑁𝑆 = 𝑓(𝑁). Число элементов сетки для каждого расчета 

можно узнать следующим образом: Utility Menu > List > Elements > Nodes 

+ Attributes.  
Также, для каждого из расчетов привести картину распределения 

компоненты напряжений 𝜎𝑥 с помощью команды General Postproc > 

Contour plot > Nodal Solution > Stress > X-component of stress и далее, 

сохранить графический файл:  Utility Menu > Plot Ctrls > Redirect plots. 

 

Требования к отчету 

Отчет должен содержать исходные данные, постановку задачи 

(обоснование выбранной расчетной модели), иллюстрацию сетки 

конечных элементов, а также результаты расчетов согласно пункту 10 

раздела «Порядок выполнения работы».  

 

Контрольные вопросы 

1) В каких случаях в инженерных расчетах можно использовать 

приближение плоского напряженного состояния? 

2) Что такое степени свободы? 

3) Каким образом можно верифицировать результаты конечно-

элементного расчета? 

 

Литература 

[1] Елисеев К.В., Зиновьева Т.В. Вычислительный практикум в 

современных расчетных CAE-системах: учебное пособие, СПб.: СПбГПУ, 

2008, 112 с. 

[2] Биргер И.А. Прочность, устойчивость, колебания. В 3 Т., Т.2, М.: 

Машиностроение, 1968, 464 с. 

[3] Тимошенко С.П., Гудьер Дж. Теория упругости. М.: Наука, 1975, 

576 с. 

  



21 

 

3.2. Плоские задачи теории упругости. Полый толстостенный цилиндр 

под внутренним давлением (задача Ляме) [Лабораторная работа №2] 

 

Краткое описание работы 

Имеется полый толстостенный цилиндр из однородного изотропного 

материала с модулем Юнга 𝐸 = 2 ∙ 105 МПа и коэффициентом Пуассона 

𝜈 = 0.3. Внутренний диаметр цилиндра 𝑅𝐵 = 0.5 м, наружный – 𝑅Н = 1.0 

м, приложенное внутреннее давление 𝑝 = 10 МПа. Предполагая, что 

цилиндр достаточно длинный, и реализуется плоское деформированное 

состояние, требуется с помощью программного комплекса конечно-

элементного анализа ANSYS получить напряженно-деформированное 

состояние цилиндра, построить графики радиальной и тангенциальной 

компоненты напряжений вдоль радиуса цилиндра и сравнить их с 

аналитическим решением.  

 

Рис. 11 Исходные данные 

Цель работы 

Продолжение знакомства с применением программного комплекса 

конечно-элементного анализа ANSYS при решении инженерных задач, 

постановка задачи о плоском деформированном состоянии, получение 

навыков обработки полученных результатов в постпроцессоре – 

построение графиков.  

 

Теоретическая справка 

Аналитические выражения для радиальной (𝜎𝑟) и окружной (𝜎𝜑) 

компоненты напряжений в рассматриваемом цилиндре имеют следующий 

вид [1]: 
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𝜎𝑟 =
𝑅𝐵
2

𝑅𝐻
2 − 𝑅𝐵

2 [1 −
𝑅𝐻
2

𝑟2
] 𝑝; 

𝜎𝜑 =
𝑅𝐵
2

𝑅𝐻
2 − 𝑅𝐵

2 [1 +
𝑅𝐻
2

𝑟2
] 𝑝. 

Следует отметить, что радиальные напряжения всюду внутри 

цилиндра сжимающие, а окружные, наоборот, растягивающие, причем 

наибольшие (по модулю) значения достигаются на внутренней 

поверхности цилиндра (при 𝑟 = 𝑅𝐵): 

𝜎𝑟 = −𝑝; 

𝜎𝜑 =
𝑅𝐻
2 + 𝑅𝐵

2

𝑅𝐻
2 − 𝑅𝐵

2 𝑝. 

 

Порядок выполнения работы 

В предположении, что цилиндр достаточно длинный, в нем вдали от 

оснований реализуется плоское деформированное состояние (𝜺̿ ∙ 𝒏̅ = 𝟎̅, где 

𝜺̿ – тензор деформаций, 𝒏̅ – вектор нормали к плоскости пластины 

(плоскости ХУ)). Данное условие физически означает, что компонента 

деформаций 𝜀𝑍𝑍 = 0.  

Кроме того, ввиду симметрии геометрии и приложенных нагрузок 

относительно оси 𝑧, в расчетной модели можно рассматривать четверть 

поперечного сечения цилиндра. 

1) Создание четверти полого круга: Main Menu > Preprocessor > Modeling 

> Create > Areas > Circle > Partial Annulus. 

В результате сразу получаем геометрию расчетной модели, как 

показано на Рис. 12. 

 

 
Рис. 12 Геометрическая модель, созданная в ANSYS 
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1) Задание свойств материала. 

 Выбрать линейно-упругий изотропный материал: 

Main Menu > Preprocessor > Material Props > Material Models. 

Для материала номер 1 (левая панель) выбрать Structural > Linear > 

Elastic > Isotropic и ввести модуль Юнга EX и коэффициент Пуассона 

PRXY. 

2) Задание элементов и их свойств. 

Перед созданием сетки необходимо выбрать тип элементов и 

добавить его из библиотеки элементов Main Menu > Preprocessor > 

Element Type > Add/Edit/Delete > Add, выбрать группу элементов 

Structural solid и в ней 4-х узловой элемент Quad 4node 182.  

В оставшемся окне для этого элемента необходимо задать 

дополнительные свойства, нажав Options. Выбрать опцию плоского 

деформированного состояния: Element behavior K3 - plane strain.  

3) Создание сетки конечных элементов. 

Переходим к созданию сетки: Main Menu > Preprocessor > Meshing. 

Сетка строится в окне MeshTool: Main Menu > Preprocessor > Meshing 

> MeshTool.  

Необходимо создать адекватную задаче сетку конечных элементов: 

так как геометрия модели не имеет концентраторов и внешняя нагрузка 

равномерно распределена по внутренней поверхности цилиндра, то не 

ожидается концентрации напряжений. Таким образом, переменный размер 

элементов не требуется. 

С помощью команды: MeshTool > Size Controls > Lines > Set 

зададим разбиение линий: по 20 элементов для прямых линий и по 40 для 

дуг окружностей. Параметр SPACE (сгущение сетки) задавать не нужно.   

Создадим сетку с помощью команды: Utility Menu > Plot > Areas. В 

окне Mesh выбрать Areas — разбивка поверхностей, — установить флажок 

Free, выбрать квадратичный элемент Quad и нажать кнопку Mesh. Мышью 

выбрать поверхность и нажать OK. Будет создана сетка, показанная на Рис. 

13. 

Задание нагрузок и граничных условий 

К внутренней дуге окружности приложено давление, на прямых 

линиях, прилежащих к отверстию, ставятся условия симметрии: UX=0 или 

UY=0, соответственно. 

Зафиксировать степени свободы на заданной линии можно 

следующим образом: Preprocessor > Loads > Define Loads > Apply > 

Structural > Displacement > On Lines. 

· выбрать мышью линию и нажать кнопку OK; 

· выбрать в списке DOFs to be constrained фиксируемые степени 

свободы. По умолчанию задается нулевое перемещение — Value можно не 

вводить.  

Приложить давление можно следующим образом: 
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Preprocessor > Loads > Define Loads > Apply > Structural > Pressure > 

On Lines. 

 

 
Рис. 13 Конечно-элементная сетка 

Выбрать мышью нужную линию и нажать кнопку OK. В поле Load 

PRES value ввести значение давления (со знаком плюс). 

4)  Запуск солвера. 

Запуск задачи на счет производится командой Solution > Solve > 

Current LS. Если нет сообщений об ошибках, в появляющемся 

диалоговом окне следует нажать кнопку OK. 

5) Обработка полученных результатов. 

Используется вкладка General Postproc. Первоначально следует 

оценить адекватность полученного решения по картине деформаций: 

General Postproc > Deformed Shape и выбрать режим отображения Def + 

undeformed. В случае физически нереалистичной картины следует искать 

ошибку в постановке задачи и в значениях заданных величин. 

Перейдем к построению графиков. Ввиду симметрии геометрии и 

нагружения, очевидно, что радиальная компонента напряжений не зависит 

от угла 𝜑, поэтому достаточно построить график продольной компоненты 

напряжений 𝜎𝑥 при 𝜑 = 0.  

Для этого нужно создать путь: General Postproc > Path Operations > 

Define Path > By Nodes. С помощью  мыши выбрать начальный и 

конечный узлы пути, в открывшемся окне задать имя пути и число 

разбиений nDiv = 15, поле nSets оставить пустым. Далее нужно выбрать 

величину, значения которой вдоль выбранного пути требуется вычислить: 

General Postproc > Path Operations > Map onto Path, в открывшемся окне 

выбрать Stress, X-direction SX. Теперь график выбранной величины можно 
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визуализировать с помощью General Postproc > Path Operations > Plot 

Path Items > On Graph, выбрав в открывшемся окне компоненту 

напряжений SX. Численные значения можно сохранить в текстовом файле:  

General Postproc > Path Operations > Plot Path Items > List Path Items.  

Аналогично, окружная компонента напряжений не зависит от угла 𝜑, 

поэтому достаточно построить график компоненты напряжений 𝜎𝑌 при 

𝜑 = 0.  

Для сравнения с аналитическим решением, полученные графики 

следует нарисовать совместно с графиками аналитических решений и 

вычислить максимальную погрешность.  

Контрольные вопросы 

1) В каких случаях в инженерных расчетах можно использовать 

приближение плоского деформированного состояния? 

2) В чем заключается стратегия выбора расчетной сетки? Насколько 

мелкой должна быть сетка? 

 

Требования к отчету 

Отчет должен содержать исходные данные, постановку задачи 

(обоснование выбранной расчетной модели), иллюстрацию сетки 

конечных элементов, а также результаты расчетов согласно пункту 6 

раздела «Порядок выполнения работы».  

 

Литература 

 [1] Биргер И.А. Прочность, устойчивость, колебания. В 3 Т., Т.2, М.: 

Машиностроение, 1968, 464 с. 

 [2] Тимошенко С.П., Гудьер Дж. Теория упругости, М.: Наука, 1975, 

576 с.  
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3.3. Плоские задачи теории упругости. Остаточные термические 

напряжения в тонкой пленке GaN на сапфировой подложке 

[Лабораторная работа №3] 

 

Краткое описание работы 

Имеется тонкая пленка GaN, ориентации [0001], выращенная на 

сапфировой подложке (на c грани сапфира) (Рис. 14). Полагаем, что все 

напряжения, возникшие в процессе роста срелаксировали. Термические 

напряжения в пленке возникают при охлаждении на ∆𝑇 = 1000 ℃ как 

следствие рассогласования коэффициентов термического напряжения 

пленки и подложки. Толщина пленки ℎ𝑓 = 2 мкм, толщина подложки ℎ𝑓 =

450 мкм. Материал пленки и подложки ортотропный, значения упругих 

модулей: для GaN: С11 = 367ГПа, С12 = 135ГПа, С13 = 103ГПа, С33 =
405ГПа, С44 = 95ГПа, для сапфира: С11 = 497ГПа, С12 = 163Па, С13 =
116ГПа, С33 = 501ГПа, С44 = 147ГПа. Коэффициенты термического 

расширения GaN: 𝛼𝑎 = 5.59 ∙ 10
−61/𝐾, 𝛼𝑐 = 3.17 ∙ 10

−61/𝐾, сапфира: 

𝛼𝑎 = 7.5 ∙ 10
−61/𝐾, 𝛼с = 8.5 ∙ 10

−61/𝐾. Требуется с помощью 

программного комплекса конечно-элементного анализа ANSYS получить 

напряженно-деформированное состояние (НДС) структуры 

пленка/подложка, найти значение напряжений 𝜎𝑥𝑥 в пленке. Подобрать 

подходящий продольный размер структуры, чтобы реализовать 

приближение тонкой пленки. Получить сеточную сходимость. Сравнить 

полученные результаты с аналитическим решением. 

 

Цель работы 

Ознакомление с возможностями программного комплекса ANSYS 

при моделировании НДС в тонких пленках; реализация приближения 

тонкой пленки, задание анизотропных свойств материалов. 

 
Рис. 14 Схема структуры GaN/сапфир 
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Теоретическая справка 

Получим аналитические выражения для напряжений в тонкой пленке 

GaN на сапфировой подложке. 

Ввиду того, что подложка толстая, упругими  деформациями и 

напряжениями в ней пренебрегаем. Отсюда следует, что изгиба верхнего 

слоя нет. 

Собственные деформации в верхнем слое по осям x и y:  𝜀∗ =
𝜀𝑥
∗ = 𝜀𝑦

∗ = (𝛼𝑎 − 𝛼̅𝑎)∆𝑇. 

Очевидно, что 𝜀𝑥𝑥 = −𝜀
∗, 𝜀𝑦𝑦 = −𝜀

∗. Ввиду симметрии и того факта, 

что кристаллографическая ось c параллельна оси z, равны нулю 

следующие компоненты тензора деформаций: 𝜀𝑥𝑦 = 0, 𝜀𝑧𝑥 = 0, 𝜀𝑧𝑦 = 0. 

Т.к. поверхность пленки не нагружена, то 𝜎𝑧𝑧 = 0.  Ввиду симметрии 

касательные напряжения в плоскостях, параллельных плоскости ХУ также 

равны нулю: 𝜎𝑥𝑦 = 0. Из граничных условий также следует, что 𝜎𝑧𝑥 = 0 и 

𝜎𝑧𝑦 = 0. 

Закон Гука: 

𝜎𝑘𝑚 = 𝐶𝑘𝑚𝑖𝑗𝜀𝑖𝑗 

или в более компактной записи (см. [3]): 

𝜎𝑖 = 𝑐𝑖𝑗𝜀𝑗. 

Для гексагональной решетки монокристалла GaN: 

с𝑖𝑗 =

(

 
 
 
 

𝐶11  𝐶12   𝐶13  0      0              0
𝐶12  𝐶11   𝐶13  0      0              0
𝐶13  𝐶13   𝐶33  0      0               0
    0    0    0   𝐶44     0               0
    0    0    0    0       𝐶44            0

       0   0    0     0       0       
С11−С12

2 )

 
 
 
 

. 

Таким образом, получаем следующие уравнения: 

{

𝜎𝑥𝑥 = 𝐶11𝜀𝑥𝑥 + 𝐶12𝜀𝑦𝑦 + 𝐶13𝜀𝑧𝑧
𝜎𝑦𝑦 = 𝐶12𝜀𝑥𝑥 + 𝐶11𝜀𝑦𝑦 + 𝐶13𝜀𝑧𝑧
𝜎𝑧𝑧 = 𝐶13𝜀𝑥𝑥 + 𝐶13𝜀𝑦𝑦 + 𝐶33𝜀𝑧𝑧

. 

С учётом граничных условий, получим: 

{
𝜎𝑥𝑥 = 𝜎𝑦𝑦 = 𝜀

∗(𝐶11 + 𝐶12) −
2𝜀∗𝐶13

2

𝐶33

𝜀𝑧𝑧 = −
2𝜀∗𝐶13

𝐶33

. 

Следует отметить, что полная деформация 𝜀𝑧𝑧 равна: 

𝜀𝑧𝑧 = −
2𝜀∗𝐶13

𝐶33
+ 𝛼𝑐Δ𝑇. 
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При Δ𝑇 = −1000℃ (охлаждение) получим следующее значение 

термических напряжений в пленке GaN: 

𝜎𝑥𝑥 = 𝜎𝑦𝑦 = −859 МПа. 

 

Порядок выполнения работы 

Рассматриваемая задача может быть решена в плоской (2D) 

постановке моделированием напряженно-деформированного состояния в 

сечении XZ с реализацией плоского деформированного состояния. 

Кроме того, ввиду симметрии геометрии, в расчетной модели будем 

рассматривать четверть структуры. 

1) Создание прямоугольника, соответствующего сапфировому 

основанию. 

Используем функцию построения прямоугольников на плоскости 

Main Menu > Preprocessor > Modeling > Create > Areas > Rectangle > 

By 2 Corners. 

Продольный размер области возьмем равным 700 мм.   

2) Создание прямоугольника, соответствующего пленке GaN. 

Main Menu > Preprocessor > Modeling > Create > Areas > Rectangle > 

By 2 Corners. 

3) Склейка областей. 

Для того чтобы при построении сетки конечных элементов на 

границы прямоугольников элементы соединялись в узлах, лежащих на 

интерфейсе, необходимо произвести операцию склейки прямоугольников. 

Main Menu > Preprocessor > Modeling > Operate > Booleans > Glue > 

Areas. 

4) Задание свойств материала. 

Выбрать линейно-упругий анизотропный материал: 

Main Menu > Preprocessor > Material Props > Material Models. 

Для GaN, материала номер 1 (левая панель) выбрать Structural > 

Linear > Elastic > Anisotropic и в открывшейся таблице ввести значения 

упругих модулей (см. Рис. 15). 

Также, необходимо задать коэффициенты термического расширения 

GaN: 

Structural > Thermal Expansion > Secant Coefficient > Orthotropic. 

Аналогично, задаем свойства для сапфира, предварительно создав 

материал 2, как показано на Рис. 16. 

5) Задание элементов и их свойств. 

Перед созданием сетки необходимо выбрать тип элементов и 

добавить его из библиотеки элементов Main Menu > Preprocessor > 

Element Type > Add/Edit/Delete > Add, выбрать группу элементов 

Structural solid и в ней 8-ми узловой элемент Quad 8node 183.  
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Рис. 15 Задание матрицы упругих модулей в ANSYS 

  

 
Рис. 16 Создание нового материала в ANSYS 
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В открывшемся окне для этого элемента необходимо задать 

дополнительные свойства, нажав Options, выбрать треугольную форму 

элементов K1 – triangle и опцию плоского деформированного состояния 

Element behavior K3 - plane strain.  

6) Создание сетки конечных элементов. 

Переходим к созданию сетки: Main Menu > Preprocessor > Meshing. 

Т.к. имеется два материала, то разобьем отдельно верхний и нижний 

прямоугольники, задав создаваемым элементам привязку к 

соответствующему материалу.  

Сетка строится в окне MeshTool: Main Menu > Preprocessor > Meshing 

> MeshTool.  

Нажимаем кнопку Set, в открывшемся окне Mesh Attributes выбираем 

материал 1.  

Зададим теперь размер элементов в окне Mesh Tool: нажимаем 

кнопку Global и устанавливаем размер элементов равный 1. 

Нажимаем кнопку Mesh, выбираем для разбиения верхний 

прямоугольник. 

Аналогично, строим сетку для нижнего прямоугольника, выбрав в 

окне Mesh Attributes материал 2, кроме того, удаляем размер элементов в 

разделе Size Ctrls > Clear, размер элементов автоматически «подстроится» 

под уже созданные элементы верхнего прямоугольника. 

Построенная сетка конечных элементов показана на Рис. 17. 

 
Рис. 17 Конечно-элементная сетка 
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7) Задание нагрузок и граничных условий. 

На левой вертикальной линии задается условие симметрии, на 

нижней горизонтальной линии – запрет перемещений UY=0. 

Зафиксировать степени свободы на заданной линии можно 

следующим образом: Preprocessor > Loads > Define Loads > Apply > 

Structural > Displacement > On Lines. 

· выбрать мышью линию и нажать кнопку OK; 

· выбрать в списке DOFs to be constrained фиксируемые степени 

свободы. По умолчанию задается нулевое перемещение — Value можно не 

вводить. 

Охлаждение структуры задается с помощью задания референсной 

температуры (температуры окружающей среды) и начальной температуры 

структуры. 

Референсная температура задается следующим образом: Solution > 

Define Loads > Settings > Reference Temp. Задаем нулевое значение. 

Начальную температуру задаем следующим образом:  Solution > 

Define Loads > Apply > Temperature > On Areas. Выбрать все области, 

нажать Ок, в открывшейся вкладке задать значение 1000. 

8)Запуск солвера.  

По умолчанию в ANSYS предполагается, что в задаче 

рассматривается статическая задача с упругими свойствами материалов, 

поэтому никаких предварительных настроек решателя делать не надо. 

Запуск задачи на счет производится командой Solution > Solve > Current 

LS. Если нет сообщений об ошибках, в появляющемся диалоговом окне 

следует нажать кнопку OK. 

9)Обработка полученных результатов. 

По окончании расчета результаты анализируются в постпроцессоре 

(вкладка General Postproc). Адекватность результатов можно 

первоначально оценить по картине деформаций: General Postproc > 

Deformed Shape и выбрать режим отображения Def + undeformed. В 

случае нереалистичной картины следует искать ошибку в постановке 

задачи и в значениях заданных величин. Чтобы найти номинальное 

значение термических напряжений в пленке, следует вывести на экран 

поле компоненты напряжений 𝜎𝑥𝑥: General Postproc > Contour plot > 

Nodal Solution > Stress > X-component of stress. 

10) Требуется на основе полученных результатов привести картину 

распределения компоненты напряжений 𝜎𝑥𝑥 с помощью команды General 

Postproc > Contour plot > Nodal Solution > Stress > X-component of stress, 

сравнить полученную величину для пленки GaN с аналитически 

вычисленным значением. 

 

Требования к отчету 

Отчет должен содержать исходные данные, постановку задачи 

(обоснование выбранной расчетной модели), иллюстрацию сетки 
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конечных элементов, а также результаты расчетов согласно пункту 10 

раздела «Порядок выполнения работы».  

 

Контрольные вопросы 

1) Какова причина остаточных термических напряжений в структуре 

GaN/сапфир? 

2) Что такое ортотропный материал? 

 

Литература 

[1] Елисеев К.В., Зиновьева Т.В.. Вычислительный практикум в 

современных расчетных CAE-системах: учебное пособие, СПб.: СПбГПУ, 

2008, 112 с. 

[2] А.И. Лурье. Теория упругости, М.: Наука, 1970, 939 с. 

[3] Дж. Най. Физические свойства кристаллов, М.: Иностранная 

литература, 1960, 376 с. 
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4. Лабораторные работы по расчету тепловых свойств материалов 

4.1. Численное моделирование процессов теплообмена в твердых 

телах. [Лабораторная работа №4] 

 

Краткое описание работы 

Светодиодные модули, выполненные по технологии «чип–на–плате» 

(англ. «chip-on-board», COB), представляют собой массив светодиодных 

чипов, установленных на единую подложку, и покрытых общим слоем 

защитного покрытия. У модулей COB есть ряд преимуществ по сравнению 

с корпусированными светодиодами: более низкая стоимость производства, 

высокая удельная мощность, компактные размеры. В данной работе будет 

произведен расчет теплопроводности в светодиодном модуле, который 

представляет из себя керамическую пластину с металлизацией, на которой 

смонтированы светодиодные чипы, покрытые слоем люминофора. 

Обеспечение теплового режима светодиодных модулей является 

ключевым элементом для повышения эффективности и долговечности 

устройств на их основе. Помимо того, что повышение температуры 

активной зоны светодиода влечет за собой падение эффективности 

светодиода и сокращение времени его службы, высокие рабочие 

температуры приводят  также к термическому гашению люминофоров [1]. 

 

Цель работы 

Приобретение навыков проведения расчетов теплообмена в твердом 

теле с помощью программного комплекса COMSOL Multiphysics.  

 

Задачи работы 

Моделирование стационарных процессов теплообмена в 

светодиодном модуле. Моделирование состоит из следующих этапов: 

импорт геометрии, создание сетки, задание граничных условий, задание 

параметров теплового расчета в твердом теле, проведение расчета, анализ 

результатов. 

 

Теоретическая справка 

Обеспечение теплового режима люминофорного покрытия 

светодиодных модулей осложняется наличием значительного 

тепловыделения в объеме люминофоросодержащего геля, обладающего 

крайне низким коэффициентом теплопроводности (около 0.2 Вт/м/К).  

Граничные условия на тепловыделение задаются на поверхности 

светодиодных кристаллов и в областях инкапсулирующего геля над 

кристаллами. (см. Рис. 18). Общая мощность светодиодного модуля 10Вт. 

Свойства материалов светодиодного модуля представлены в Таблица 

2. Свойства материалов можно сопоставить с элементами геометрии, 

используя Рис. 18. 



34 

 

 

Рис. 18 Принципиальная схема расчетной области светодиодного модуля 

Порядок выполнения работы 

1. Создается новый проект для статического расчета теплообмена в 

программном комплексе COMSOL. 

2. Геометрия расчетной области импортируется из файла module.igs 

через пункты меню Model1 > Geometry1>Import1. Файл (или 

ссылка на файл) выдается преподавателем. 

Задаются свойства материалов в пункте меню Materials (см. Рис. 19). 

 

Рис. 19 Добавление нового материала 
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Свойства материалов задаются согласно схеме на Рис. 18 и Таблица 2. 

Таблица 2 Свойства материалов светодиодного модуля 

Материал Теплопроводность, Вт/м/K 

Алюминий 160 

Инкапсулирующий гель(покрытие) 0.2 

Серебро 429 

Оксидная керамика (Al2O3) 19 

Сапфир 23 

Термоклей 5 

Термопаста  3 

3. Задаются граничные условия на поверхности чипов в пункте меню Heat 

Transfer: Boundary Heat Source c параметром Total boundary power 

равным 6Вт (место задания граничных условий обозначено на Рис. 20). 

 

Рис. 20 Граничные условия на подвод тепла на поверхности чипов 

Данные граничные условия описывают тепловыделение в активной 

области светодиодных чипов. 

4. Задаются граничные условия в объеме инкапсулирующего геля над 

чипами, используя пункт меню Heat Transfer: 

Heat Source c параметром Total power равным 1Вт. 

Данные граничные условия описывают тепловыделение в объеме 

инкапсулирующего геля в процессе работы содержащегося в нем 

люминофора. 

5. Задаются граничные условия на поверхности алюминиевого 

основания, используя пункт меню Heat Transfer: 

Граничные 

условия на 

подвод тепла 
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Temperature c параметром Temperature равным 298.15K (место 

задания граничных условий обозначено на Рис. 21). 

 

Рис. 21 Граничные условия на температуру 

Данные граничные условия необходимы для моделирования 

теплоотвода от светодиодного. 

6. Для генерации сетки в расчетной области используется пункт меню 

Mesh>Build All c параметром Finer (пример расчетной сетки 

изображен на Рис. 22). 

 

Рис. 22 Пример расчетной сетки 

Требования к отчету 

Отчет должен содержать исходные данные, постановку задачи, 

обоснование выбранной расчетной модели, иллюстрацию сетки конечных 

элементов, а также результаты расчетов согласно пункту 9 раздела 

«Порядок выполнения работы»: значение максимальной температуры на 

поверхности инкапсулирующего геля, распределение температуры по 

поверхности светодиодного модуля.  

7. Для проведения расчета используется пункт в меню Study>Compute. 

 

Граничные условия 

на температуру 
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Рис. 23 Запуск расчета 

8. Для оценки максимальной температуры на поверхности 

светодиодного модуля, используется пункт меню Results> 

Temperature. 

 

Литература 

[1] L. Chen, C.C. Lin, C.W. Yeh, R.S. Liu, Light converting inorganic 

phosphors for white light-emitting diodes. – Materials, 2010, Vol. 3, p. 2172-

2195; DOI: 10.3390/ma3032172. 
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4.2. Численное моделирование процессов конвекции 

[Лабораторная работа №5] 

 

Краткое описание работы 

Пластиковые радиаторы приобрели значительное распространение с 

появлением светильников на основе светодиодов, что связано с достаточно 

жесткими требованиями светодиодов к обеспечению низких температур в 

активной области светодиодных чипов, а также с их относительно низкой 

тепловой мощностью. Пластиковые радиаторы широко используются в 

ретрофитных светодиодных лампах под цоколь Е14 и Е27 [1]. 

 

Цель работы 

Приобретение навыков теплового расчета для радиатора 

светодиодной лампы и совместного расчета течения газа в окрестности 

радиатора для моделирования конвективного теплообмена. Для 

выполнения работы используется программный комплекс для численного 

моделирования ANSYS CFX. 

 

Задачи работы 

Моделирование стационарного процесса теплообмена радиатора 

светодиодной лампы с окружающей средой с учетом свободно 

конвективных течений. Данное моделирование полезно при разработке 

систем теплоотвода ламп на основе светодиодов. 

Имеется пластиковый радиатор, использующийся в ретрофитных 

светодиодных светильниках, тепловыделение происходит в светодиодном 

модуле, закрепленном на поверхности данного радиатора. (Рис. 24) 

 

Рис. 24 Схема расчетной области исследуемой конструкции и граничные 

условия 
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Порядок выполнения работы будет описан для пяти программных 

модулей, содержащихся в программном комплексе ANSYS CFX: 

1. ANSYS DesignModeller – программа, предназначенная для создания, 

импортирования и модифицирования геометрии. 

2. ANSYS Meshing – программа, предназначенная для создания 

расчетных сеток. 

3. ANSYS CFX – Pre – программа предназначена для задания 

граничных условий, свойств материалов и параметров решателя. 

4. ANSYS CFX – Solver Manager – программа для управления 

решателем и контроля сходимости решения. 

5. ANSYS CFD – Post – программа для постпроцессинга и обработки 

результатов. 

Все упомянутые выше модули объединяются программной 

оболочкой ANSYS Workbench и не требуют передачи файлов из одного 

модуля в другой пользователем. 

 

Порядок выполнения работы в ANSYS DesignModeller 

1.  Импортировать файл геометрии lamp.igs. Файл (или ссылка на файл) 

выдается преподавателем. 

2. Обеспечить отсутствие пересечений объемов (необходимо для 

корректной работы программы) функцией 

Create>Boolean(Substract). Для этого необходимо последовательно 

вычесть объемы лампы: Sink, Chip, Spreader из объема газа: Fluid, с 

сохранением изначальных объемов (параметр Preserve Tool Bodies 

со значением Yes). 

3. Обеспечить согласованность поверхностей тела радиатора и объема 

несжимаемого газа командой Tools>Face Split. 

Порядок выполнения работы в ANSYS Meshing 

1. Задать пограничный слой в объеме Fluid на всех твердых 

поверхностях с использованием функции Mesh>Inflation c 

настройками Transition Ratio 1.2. 

2. Для достаточно мелкого разбиения сетки объема газа задать размер 

элементов на поверхностях радиатора в объеме Fluid с настройками 

параметра Face Sizing>Element Size со значением 3e-4. 

3. Для достаточно мелкого разбиения сетки внутри твердых тел задать 

размеры элементов в твердых телах, используя функцию Body 

Sizing>Element Size со значением 4е-4. 

4. Создать наборы граней твердых тел и объема газа для последующего 

создания интерфейсов между ними (все наборы твердых тел и 

объема жидкости должны совпадать), используя команду Named 

Selection>Insert. 

5. Сгенерировать сетку, используя команду Mesh>Update (пример 

сетки изображен на Рис. 25). 
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Рис. 25 Пример сгенерированной сетки 

Порядок выполнения работы в ANSYS CFX - Pre 

1. Создать набор материалов (Таблица 1), используя команду 

Materials>Insert>Material. 

2. Создать отдельные расчетные области для каждого объема, 

используя команду Flow Analysis>Insert>Domain, в процессе 

создания указать следующие параметры: 

 Basic Settings>Domain Type: Solid Domain для твердых тел, Fluid 

Domain для объема газа. 

 Basic Settings>Material следует выбрать соответствующий 

материал (свойства материалов указаны в Таблице 3). 

Таблица 3 Свойства материалов радиатора светодиодного светильника 

 Solid Models>Heat transfer (для твердых тел) следует выбрать 

параметр Thermal Energy. 

 Buoyancy Model>Option>Buoyant. 

 Buoyancy Model>Gravity X Dirn.>0. 

Материал Теплопроводность, Вт/м/К 

Алюминий 237 

Пластик Радиатора 8 

Материал модуля 0.5 
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 Buoyancy Model>Gravity Y Dirn.>9.8. 

 Buoyancy Model>Gravity Z Dirn.>0. 

 Fluid Models>Heat Transfer>Thermal Energy. 

 Fluid Models>Turbulence>None(Laminar). 

3. Задать интерфейсы, используя функцию Interfaces>Insert>Domain 

Interface. 

4. Задать Expert Parameters>tbulk for htc>298.15. 

5. Задать граничные условия согласно Ошибка! Источник ссылки не 

айден., используя функцию “Имя Домена”>Insert>Boundary: 

7681.29 Вт/м2 для условия на тепловой поток и 298.15 °К на 

температуру на открытой границе. 

6. Задать параметры солвера: 

 Sovler Control>Max.Iterations>4000. 

 Sovler Control>Convergence Criteria>Residual Type>MAX. 

 Sovler Control>Convergence Criteria>Residual Target>0.000001. 

Порядок выполнения работы в ANSYS CFX – Solver Manager 

1. Расчет запускается кнопкой Start Run. 

2. Расчет останавливается кнопкой STOP при достижении сходимости 

(падение невязок менее 1е-4 и прекращение их падения). 

Порядок выполнения работы в ANSYS CFD - Post 

1. Создается выражение, используя функцию Expressions>New… вида: 

maxVal(Temperature)@Spreader. 

2. Записывается значение максимальной температуры в отчет. 

Требования к отчету 

Отчет должен содержать исходные данные, постановку задачи, 

иллюстрацию сетки конечных объемов, а также результаты расчетов 

согласно пункту «Порядок выполнения работы в ANSYS CFD - Post» 

раздела «Порядок выполнения работы»: значение максимальной 

температуры. 

Литература 

[1] http://www.osram.com/osram_com/products/lamps/led-retrofit-

lamps/consumer-led-reflector-lamps/index.jsp 

  

http://www.osram.com/osram_com/products/lamps/led-retrofit-lamps/consumer-led-reflector-lamps/index.jsp
http://www.osram.com/osram_com/products/lamps/led-retrofit-lamps/consumer-led-reflector-lamps/index.jsp
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4.3. Анализ процессов теплообмена на основании численных 

расчетов и эксперимента [Лабораторная работа №6] 

 

Краткое описание работы 

В данной работе будет произведен анализ результатов, полученных в 

лабораторных работах 4 и 5. 

 

Цель работы 

Изучение углубленных методик анализа полученных результатов 

численных расчетов выполненных в лабораторных работах 4 и 5. 

Ознакомление с числами подобия, участвующими в анализе теплообмена, 

например, число Нуссельта. 

 

Задачи работы 

Проведение анализа результатов работы 4, в частности, построение 

графика распределения температуры на произвольном отрезке 

пространства внутри расчетной области. Экспорт данных. Проведение 

анализа результатов работы 5. Построение графиков распределения 

температуры на произвольных участках исследуемых светильников и 

светодиодных модулей. Построение распределения числа Нуссельта. 

 

Теоретическая справка 

Число Нуссельта является основным числом подобия, 

использующимся для анализа тепловых процессов теплоотвода с участием 

вынужденной и свободной конвекции, определяется формулой: 

 

где 

q – тепловой поток; 

Tw – температура стенки; 

L – характерная длина; 

kf – коэффициент теплопроводности воздуха; 

Tref = 25°C. 

Число Нуссельта показывает отношение конвективного теплового 

потока к диффузионному тепловому потоку, то есть, показывает роль 

конвекции в процессе теплоотвода в окружающую среду. Чем выше число 

Нуссельта, тем быстрее происходит конвективный теплоотвод с 

поверхности. 

  

𝑁𝑢 =

𝑞
(𝑇𝑤 − 𝑇𝑟𝑒𝑓)

𝐿

𝑘𝑓
, 
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Порядок выполнения работы в COMSOL 

1. Создается отрезок для последующего отображения распределения 

температуры вдоль него в произвольном пространстве расчетной 

области при помощи функции Results>Data Set> Cut Line 3D, 

задание отрезка происходит по координатам двух точек. Отрезок 

отображается в окне Graphics. 

Замечание: если отрезок не отображается в графическом окне, 

значит, он задан вне расчетной области. 

2. Создается график распределения температуры вдоль созданного 

отрезка посредством функции Results>1D Plot Group>Line Graph с 

параметрами Data set>Cut Line 3D (пример такого графика показан 

на Рис. 26).  

 

Рис. 26 Пример распределения температуры по поверхности 

инкапсулирующего геля 

Порядок выполнения работы в ANSYS 

Создание графика распределения температуры на произвольном 

отрезке: 

1. Создание произвольного отрезка для последующего отображения 

результатов, используя команду User Locations and 

Plot>Insert>Location>Line линия задается по двум точкам. 

2. Задать необходимое количество точек на отрезке для корректного 

отображения распределения температуры, задав параметр Line 

Type>Samples>100. 
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3. Добавить график, используя команду Report>Insert>Chart со 

следующими параметрами: 

 Data Series>Data Source>Location>Line 1 – задает источник 

данных для графика; 

 Y Axis>Data Selection>Variable>Temperature – задается 

физическая величина для отображения на графике. 

Построение распределения числа Нуссельта 

1. Задание выражения для новой переменной с использованием 

команды Expression>New, выражение для новой переменной имеет 

вид: 

-0.04[m]*Wall Heat Flux/(Temperature-298.15[K])/0.0261[W*m^-1*K^-

1]. 

2. Задание новой переменной с использованием команды 

Variables>New, при задании новой переменной следует выбрать 

выражение, ранее созданное в пункте 1 данного раздела. 

3. Для отображения полученного распределения числа Нуссельта 

следует включить отображение поверхностей радиатора (Рис. 27). 

 

Рис. 27 Включение отображения поверхностей радиатора 

 

 

Рис. 28 Пример распределения числа Нуссельта 
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4. Выбор отображения распределения числа Нуссельта на выбранных 

поверхностях радиатора с использованием команд: 

 «Название поверхности»>Mode>Variable. 

 «Название поверхности»>Variable>»Название переменной». 

5. Задание границ числа Нуссельта с использованием команды 

«Название поверхности»>Range>User Specified. 

Требования к отчету 

Отчет должен содержать полученные результаты анализа, а также 

выводы на основе полученных результатов анализа, в процессе 

написания вывода следует уделить внимание возможным путям 

улучшения теплоотвода.  
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В 2009 году Университет стал победителем многоэтапного конкурса, в 

результате которого определены 12 ведущих университетов России, 

которым присвоена категория «Национальный исследовательский 

университет». Министерством образования и науки Российской Федерации 

была утверждена программа его развития  на 2009–2018 годы. В 2011 году 

Университет получил наименование «Санкт-Петербургский национальный 

исследовательский университет информационных технологий, механики и 

оптики» 

 

КАФЕДРА СВЕТОДИОДНЫХ ТЕХНОЛОГИЙ 

 

Базовая магистерская кафедра светодиодных технологий была 

основана 4 октября 2011 года в рамках осуществления программы 

стратегического партнерства между федеральным государственным 

бюджетным образовательным учреждением высшего профессионального 

образования «Санкт-Петербургский национальный исследовательский 

университет информационных технологий, механики и оптики» (НИУ 

ИТМО) и российской компанией «Оптоган», обладающей уникальными 

технологиями производства светодиодов и светодиодной техники. Кафедра 

организована в составе факультета оптико-информационных систем и 

технологий НИУ ИТМО. 

С момента основания кафедры её заведующим является Владислав 

Евгеньевич Бугров, исполнительный вице-президент компании «Оптоган», 

курирующий направления научных исследований и разработок компании. 

Сотрудники кафедры — ведущие специалисты в области физики и 

технологии полупроводниковых наногетероструктур и приборов, 

физического материаловедения, а также производства светодиодов и 

светодиодных устройств. На сегодняшний день кафедра светодиодных 

технологий и компания «Оптоган» успешно реализуют ряд совместных 

научно-исследовательских проектов. 

На кафедре проводится обучение магистров по направлению 200400 

«Оптотехника» по программе 200400.68 «Светодиодные технологии» и 

аспирантов по специальностям 01.04.05 — «Оптика», 05.11.07 — 

«Оптические и оптоэлектронные приборы и комплексы», 01.04.14 — 

«Теплофизика и теоретическая теплотехника», 01.02.04 — «Механика 



47 

 

деформируемого твердого тела». Целью обучения является подготовка 

высококвалифицированных специалистов, обладающих компетенциями и 

навыками для работы в инновационной сфере светодиодных технологий. 

Светодиодные технологии — это наукоёмкое постоянно 

развивающееся направление в современной технике, основанное на 

последних разработках физики полупроводников, оптики и науки о 

материалах. Освоение программы по профилю «Светодиодные 

технологии» выводит студентов на высокий научный и познавательный 

уровень, предоставляя широкие возможности выбора и получения 

высокооплачиваемой и увлекательной работы в ведущих 

высокотехнологичных компаниях. 

Более подробную информацию о кафедре светодиодных технологий 

вы можете получить на сайте кафедры http://led.ifmo.ru/. Ознакомиться с 

инновационной деятельностью компании «Оптоган» и выпускаемой 

продукцией можно на сайте http://www.optogan.ru/. Современные научные 

исследования, разработки и достижения компании, а также актуальные 

научно-исследовательские проекты представлены на сайте 

http://www.nts.optogan.ru/. 

  

http://led.ifmo.ru/
http://www.optogan.ru/
http://www.nts.optogan.ru/
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